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Before we get started:

This is an Introduction to Excel Class. 

· In this class we are going to explore the basic features of spreadsheets using Microsoft  Excel 2003.  

· This is an introductory level course for providers with little or no exposure to Excel.  Some of the information we will review will be very basic.  

· Some of the information we will review will be very basic.  This class is not for you if you are an experienced Excel user or if you know how to create macros. 

Please raise your hand if you have problems and a room assistant will help you.

Don’t hesitate to let us know if we need to slow down
At the end of the course, there will be time for question and answers.  Please write your question down on the 3 X 5 cards provided for you and pass them to a room assistant.

Hand-on courses are best enjoyed without interruption from the noise generating electronic devises most of us have become addicted to.  Please take a moment and turn OFF all pagers, cell phones, Blackberries, i-phones, and whatever other devices make a noise. 

By the end of the course you will be able to:

· Set up a worksheet

· Customize a worksheet

· Formatting 

· Work with data

· Set up basic calculations and formulas

· Import data

· Create charts
Let’s start by finding and opening Excel. 

Click on the Start button in the lower left hand corner of your desktop.

Click on “All programs”

Select Microsoft Office

Select Microsoft Office Excel 2003 by using a left mouse click.

In this section we will cover some basics of data entry 
1. how to enter different kinds of data

2. how to edit data

3. how to add and delete extra columns and rows. 

After completing this section you will be able to:

· Create a new workbook. 

· Enter text and numbers. 

· Edit text and numbers. 

· Insert and delete columns and rows. 
When you open Excel you see a large empty grid. 
There are letters across the top 
There are numbers down the left side. 

There are tabs at the bottom named Sheet1, Sheet2 and Sheet 3.
Let’s begin by reviewing some Excel basics 

The file you have just opened is called a workbook. 
Each workbook comes with three worksheets, like pages in a document.

Worksheets are also called spreadsheets.
You enter data into the spreadsheets.

Each spreadsheet has a name on its sheet tab at the bottom left of the workbook window: Sheet1, Sheet2, and Sheet3. 
You view a worksheet by clicking its sheet tab.

It's a good idea to rename the sheet tabs to make the information on each sheet easier to identify.   

Let’s take a minute to do this now. 
Right click on Sheet1, then select “Rename”.  Then type CBOC 1

To move to Sheet 2 you can just use your mouse to select Sheet 2 or you can use a keyboard shortcut: Press CTRL+PAGE DOWN. 

Right click on Sheet2, then select “Rename”.  Then type CBOC 2

Right click on Sheet3, then select “Rename”.  Then type CBOC 3

You can Apply a Tab Color

If you will be working with multiple spreadsheets, a trick you may find useful is to set each tab to be a separate color.  Let’s take a minute to set the tab colors.  To do this:

Select the tab CBOC1, right click, select Tab color, select Red then click “OK”.

Select the tab CBOC2, right click, select Tab color, select Blue then click “OK”.

Select the tab CBOC3, right click, select Tab color, select Yellow then click “OK”.

You can add additional spreadsheets if you need more than three. 
To add an additional spreadsheet, select the last tab, right click and select “Insert”, then select worksheet, click “OK”

Note that Excel inserts the new worksheet to the left of the tab you originally selected.

Let’s move Sheet 4 to the right of CBOC 3:

Select Sheet4, right click, then select “Move or Copy”, then select (Move to end)

Since we are not going to use Sheet 4 let’s delete it.  Select sheet4, right click, select delete.

You can use keyboard shortcuts to move between worksheets.
	Move to the next sheet in the workbook.          CTRL+PAGE DOWN

	Move to the previous sheet in the workbook.   CTRL+PAGE UP


Each Worksheets is divided into columns, rows, and cells. 
Columns run vertically from top to bottom.

Each column has an alphabetical heading at the top. The first 26 columns have the letters from A through Z. Each worksheet contains 256 columns in all, so after Z the letters begin again in pairs, AA through AZ. See Figure 2.

After AZ, the letter pairs start again with columns BA through BZ, etc

Rows run horizontally from left to right on the worksheet

Row headings are numbers, from 1 through  65,536.

A cell is the space where one column and one row meet.
The cell name (or cell reference) is the column letter followed by the row number

There are over 16 Million  cells to work in on each worksheet. You could get lost without the cell reference to tell you where you are. 
Cells are where data is entered. 

When you open a new workbook, the first cell in the upper-left corner of the worksheet you see is outlined in black. The black outline indicates that any data you enter will go there.
If you want to enter data in a different cell, just click on that cell
When you select any cell, it becomes the active cell. When a cell is active, it is outlined in black, and the headings for the column and the row in which the cell is located are highlighted.
For example if you select a cell in column C on row 5, the headings on column C and row 5 are highlighted, and the cell is outlined. That cell is known as cell C5, which is the cell reference. This makes it easier for you to see that cell C5 is the active cell. 
Also, the cell reference of the active cell appears in the Name Box in the upper-left corner of the worksheet. By looking in the Name Box, you can see the cell reference of the active cell.
All of these indicators are not too important when you're right at the very top of the worksheet in the very first few cells. But when you work further and further down or across the worksheet, they can really help you out.
It’s also important to know the cell reference if you need to tell someone where specific data is located in a worksheet. Suppose, for example, that your mortgage payment, your bonus, or your job title is located in cell E35 (or cell BF684).
You can use the Name Box to go straight to cells located anywhere on the worksheet.  Click in the Name box and type BB44.   Now click and enter A1 to return to the first cell.
SAVE YOUR DATA FREQUENTLY - It’’s a good idea as you are working with Excel to save your document regularly.  Let’s do that now.

Select the “FILE”  Menu / Select “Save”

Select “Desktop”  

In the filename box type “CBOC Data”
Notice that in the Save as type box near the bottom of the Save As dialog box, Microsoft Office Excel Workbook is listed. Excel workbooks have an .xls file extension. 
Click Save. 
Now find and open the workbook. On the File menu, click Open. 

Look on your Desktop.
Or you can look at the bottom of the file menu and you should see the name of the Last Excel file you were working on.
Entering data
Now let’s enter data into the worksheets

You can enter two basic kinds of data into worksheet cells: numbers and text. 

You can use Excel to create budgets, to work with taxes, or to record student grades. 

You can even use Excel to track how much you exercise every day, and your weight loss. The possibilities really are endless.

When you enter data, it's a good idea to start by entering titles at the top of each column, so that anyone can understand what the data means.

Select cell A1.   Type “Month”

Select cell A2.   Type “January”

Press “Enter”.   Notice that cell A3 is now the active cell Type “February” into A3

ENTER moves the selection down one cell.

Note that the lower right hand corner of cell A2 is thicker.  Move your cursor over this corner until you get a cross, then pull the cross down to cell A13.  Note that Excel automatically knows that you are entering months.  This is called AutoFill
Use AutoFill to enter the months of the year, the days of the week, multiples of 2 or 3, or other data in a series. You type one or more entries, and then extend the series.
AutoComplete    If the first few letters you type in a cell match an entry you've already made in that column, Excel will fill in the remaining characters for you. Let’s try this.

In cell A15 Type in “Donald Duck”

In cell A16 Type in “Don”

Notice how Excel completes the entry for you

Now we’ll try some helpful tricks for fixing entry errors.

Escape key – you can use the escape key to delete entry in a cell while you are typing. Let’s try this.

Select cell A18.

Type in “Fev” 

Since this is an obvious error, use the Esc key in the upper left hand corner to delete the text

Type in “Februarr” You can use the Backspace key to delete the last letter
(Next: Formatting Cells)

Formatting Cells (numbers)
In this next exercise, we will learn how to format numbers

Select cell B1, type in ”Cost”

Press TAB. 
Note that TAB moves the selection to the right

In cell C1, type in ”Percent”

In cell B2 enter 1 followed by 6 zeroes then hit the enter key.
Notice how unclear this number is at a quick glance.

Select cell B2.

Select “Format” menu

Select “Cell”

Excel defaults to  “Number” tab

Under “category”:  select “number”

Change decimal place to “0”

Click in the box to the left of “Use 1000 Separator”/ Click “OK”
Note that we titled Column B as cost.  If we want the cost to display as dollars, we need to go back and format Column B.

Select “Format” 

Select “Cell”

It defaults to “Number” tab

Select “Currency” / Select the dollar sign symbol. Click “OK”

Now let’s try entering a decimal and then changing the formatting to a percentage
In cell C2 enter .33 then hit the enter key.
Let’s convert this decimal to a percentage

Select cell C2.

Select “Format” menu

Select “Cell”

Under “category”:  select “Percentage”

Change decimal place to “0”

Click “OK”

Now let’s format Column C so that all future entries are converted to percentages:

Select the “C’ header.  Note that the entire column is grayed in.

Rather than go to the Format menu, let’s try another way:

Right click: 

Select “Format” 

Select “Cell”

Select “Number” tab

Under “category”:  select “Percentage”

Change decimal place to “0”

Click “OK”

To test this, enter “22” in cell C3

Other formatting
Social security number

Type in nine “1”’s into cell D16  

          (Unclick then re-select)
Select “Format” menu

Select “Cell”

Under “category”:  select “Special”

Select “Social Security Number”

Click “OK”

Date  /Time

Now we will enter a Date 
To enter a date, select cell F1  
You should use a slash or a hyphen to separate the parts: 7/16/2008 or 16-July-2005. Excel will recognize this as a date.
Click enter; then re-select

To format the date to your personal preference, 

Select the cell that you would like to format

Select “Format” menu

Select “Cell”

Select the “Number” tab
Then choose one of the formats listed in the type box

Now let’s enter a time, Select G1 then type in “9:00” 

Click enter; then re-select
Look in the formula bar .  Note that Excel recognizes a time and enters it as AM
To enter 9 PM, type in “9:00_p”  be sure to leave a space between the time and “p”

Click enter; then re-select

Look in the formula bar .  Note that 9:00 PM has been entered.

Tip     To enter today's date, press CTRL and the semicolon together. 
To enter the current time, press CTRL and SHIFT and the semicolon all at once. 

(Next: Tips on formatting numbers)

Now for some helpful tips about entering and formatting numbers
When text is too long for a cell

Sometimes the text you enter is too long for the cell you enter it into. In this exercise you'll see how to handle that.

1. In cell D2, type this is very long, and press ENTER. The text overlaps into the next cell E2 

2. Select cell E2. Type ABC (just ignore the text that overlaps from C6) and press ENTER. 

Now you can no longer see all the text in cell D2.

3. Select cell D2. Look in the formula bar. You can see all the text you originally typed. 

4. You can make the column wider, so that you see all the text in the cell. Point at the right column boundary of column D, between the column headings D and E (up at the top, not in the worksheet), until the pointer changes to a dark cross with two arrow points. 

Double-click the right column boundary of column D. The column will widen so that all of the text in cell D2 is visible.
Let’s see how excel handles a column that is too narrow to show all the numbers.

Narrow column B until the $1,000,000 turns into a string of pound signs.

When numbers or dates are too wide to fit into a cell, you'll see this: ########. Double-click the right column boundary next to the column heading, and the column will widen

Hiding and Deleting a column

In the next part, we are going to hide columns, add columns and delete columns

To insert a column, click any cell in the column immediately to the right of where you want the new column to go. So if you want to add a  column between  B and C, Click column C. 
Click on the Insert menu

Click Columns.
The same thing can be done with rows.

Note that Excel gives a new column or row the heading its place requires, and changes the headings of later columns and rows. 
Deleting a column is also easy – select the new column C
Click a cell in column C. 
Click on the Edit menu

Click Delete.
An easier way to insert and delete columns is to select the column and then right click

To undo a deletion, click on the undo arrow button  or use the keyboard shortcut: CTRL+Z
FORMULAS

Lets’ clean up our worksheet and enter the rest of the data in preparation for working with formulas.
To copy the contents of one cell: highlight the cell right click and select copy.

Let’s try this.

Select B2

Right Click

Select copy

Note that the cell you have just copied to the clipboard is now outlined in a moving dotted line. Drag your cursor from the selected cell down to the last cell: B13

Right click

Select paste

Now let’s fill in cells C3 through C13

 .35  .40  .45  .50  .55  .60  .65  .70  .75  .80  .85

We are now going to create a formula to divide the number in column B by the number in column C.

All formulas start with the = sign

In Cell D2: type the following     =B2*C2

Hit the enter key.

Note that the display in cell D3 reads: $330,000.00

Now select cell D3 – note in the formula bar the formula is displayed.

Note that all formulas start with the = sign

Let’s try some other formulas

In Cell F2 type in 10; in G2 type in 2.  In H2 type in =F2/G2 then click “enter”

In Cell F3 type in 10; in G3 type in 2.  In H3 type in =F3-G3 then click “enter”

In Cell F4 type in 10; in G4 type in 20.   In H4 type in =F4+g4 then click “enter”

For complex formulas, use parentheses to group functions much as you would do in algebra.  In H5 type in the following formula: =(F4+G4)/(F2/G2)     ( answer = 6 )

It’s time to save our work again: please go to file and click “save” or use the disc icon to “save”

Let’s apply some of these skills to modify an excel spreadsheet downloaded from the OQP website.

CBOC

Why would we want to do this ?   Being able to modify a spreadsheet that someone else has sent you enables you to focus in on the pertinent data that you need for your analysis.
In this example, someone sent us Community Based Outpatient Clinic data from all CBOC’s in VHA for quarter 2 FY07.  We may only be interested in looking at data from One VISN.  

The first thing to notice is that Excel opens to whatever worksheet was open at the time the last SAVE was done.  In this case it is opening to VISN 10 data.   For new Excel users as well as some experienced users, this can be confusing if you don’t remember to look at the tabs and select just the information you are looking for.
[image: image1.png]] e Edt Vew Inett Fomat Iods Dota Window Help QIMauros Type aquestion for e < = B X
YT DN NN Y AT SR AR AL R Y AN ) (Y |
B et ot R =R L2\, ) X3 Replyth changes, . End Review.., Ji

; aril -0 -|B 7 U|E
G5 - A Percent
A D E F H T 7 K L ] N G|
1 Cancer
2| Community Based Outpatient Cii Calon Forale Fleart Failure
3| FY2007 02 (December - February)
VISN = 10 CA - Colorectal Screen | CA- Breast Sereen CA- Cenical Screen | HF - Outpt LVEF <40 n FF - Ou
(HEDIS) (HEDIS) (HEDIS) ACEI docurr
4
5] Facility/CBOC Staff__ Size Percent || Denominator| Percent _|Denominator| Percent ] Denominator| Percent | Denominator| _Percent
6| Chillicothe 7% 180 8% E 6% 2 0% 7 9%
7| Athens v GE 1000 = q s i = q s i =
8| Potsmouth v GE 1000 = q @ q = q @ q =
9| Marietta v GE 1000 = q @ q = q @ q =
10 Lancaster v GE 1000 = q @ q = q @ q =
i1 Cambridge v LTi000 & q @ q & q @ i &
12| Cincinnat 73% 185 79% 2 90% 21 100% 5 100%
13| Bele v GE 1000 = q s i = q s i =
14| Cincinnati (Clermont County) v GE 1000 = q @ q = q @ q =
15| Lawrenceburg (Dearbom County) v GE 1000 = q @ q = q @ q =
16| Florence v LTi000 & q @ q & q @ q &
17| Cleveland-Wade Park 7% 599 94% E 93% 4 100% 17| 79%
18| Canton v GE 1000 = q s i = q s i =
19| Youngstown v GE 1000 = q @ q = q @ q =
20| Lorain v GE 1000 = q @ q = q @ q =
21| Sandusky v GE 1000 = q @ q = q @ q =
2| Mansfield v GE 1000 = q @ q = q @ q =
23| McCaferty v GE 1000 = q @ q = q @ q =
24| Painesyile v GE 1000 = q @ q = q @ q =
25| Akron v GE 1000 = q @ q = q @ q =
26|  East Liverpool v GE 1000 = q @ q = q @ q =
27| Waren v GE 1000 = q @ q = q @ q =
28| New Philadelphia v GE 1000 = q @ q = q @ q =
29| Ravenna v GE 1000 & q @ i & q @ i &
501 Dauton 700 on1 anon £l 1ok, 2 1ok, & fro ¥
16> 1 National {VISN 7 {VISN B VIS 8 \VISN 10,/ <

Draw: s | Autoshapesw \ N IO A A @S-~ A-S
Ready





Click on the tab labeled “VISN 8”

Let’s assume for the purposes of this exercise that I am only interested in the CBOC data from VISN 8 and specifically only for the CBOC’s under “Tampa VA” and further only for cancer screening data.
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Since I am not interested in Bay Pines or Miami Data, I want to hide this data.

To do this. Select Rows 6 through Row 24 by clicking on the number 6 in the row name and dragging your mouse down to the number 24.

Right click and select  “HIDE”

Repeat for Row 25 through row 48.   Right click and select  “HIDE”

You can also hide column by selecting the column name and dragging the mouse from M to HE.

Right click and select  “HIDE”

STOP:  Not the scroll bar at the bottom of the page

Now let’s check and see how this report will look when we print it.

To check the PRINT PREVIEW , click on the icon in the toolbar that looks like a magnifier over a paper document.
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Note that with the current print set-up, this will not print out to one sheet.

To Format printing: click on SET-UP
On the page tab, click on the radio button before LANDSCAPE. Click OK
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Now check the Print Preview.  We’ll need to adjust our top and bottom margins:

Click on SET-UP

Click on the Margins tab

Set Upper Margin to .50
Set Lower Margin to .25

Click  CENTER ON PAGE HORIZONTALLY

CENTER ON PAGE VERTICALLY

Note that the scroll bar is near the top, suggesting that there are several additional pages.

Pull the scroll bar down all the way.

Note that you are on page 12.  Pages 2 through 12 are blank.  If you had printed this you would have one page of print and blank pages.

Note that there is a “2” near the bottom

Click on “CLOSE”

Now scroll down to the end of the excel worksheet…at the bottom, you will note that there is a  “2” entered into cell “G 1347”.   Delete the 2.  

Then click on the Print Preview.  Note that the worksheet is not only one page in length – if you print this now, only one page prints
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The other thing you could have done, is to have instructed Excel only to print the first page.

Click on Print Preview. Now click on Print.  Instead of leaving the “ALL” checked just enter “1” after From and “1” after To, then click OK
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Note that in this spreadsheet, the row headers appear to be frozen in place.  

You can freeze the Rows above or the Columns to the left of a selected cell

To show you how easy this is, let’s set up an additional worksheet.

Right click on any tab, select INSERT, then select worksheet, then click OK

On your new worksheet: 

Type in cell B1Colorectal Ca Screen

In Cell C1 type in Breast Ca screen
In cell D1 type in Cervical ca Screen

Select Cell A2, select WINDOWS drop down menu, select FREEZE PANES

Randomly fill in data beneath your column headers and test out the Freeze Frame option

Let’s make the column headers bold and centered.

To do this:

Select the column header cells (B1 through D1)

Then click the Bold icon  (B)

Then click the Center icon
Let’s also practice making columns wider, this time by setting the column width.

To do this 

Select columns B through D

Right click

Select Column Width

Type in 19
802 Data – Creating local Performance Measure report from clinical reminders report output  
During this next portion of this class, you will walk through a dry run of running a reminder report which produces  run in a delimited format
Click on the  Vista icon
Access Code is:  nnVEHU    where nn is the student number on the card at your desk.

Verify Code is:    VEHUnn     where nn is the student number on the card at your desk.

(Instructor used 00VEHU  and VEHU00  ) 

Type in “Rem”

RP    Reminder Reports

D      Reminders Due Report

Select an existing REPORT TEMPLATE or return to continue:  (hit enter key)

   Select one of the following:

          I         Individual Patient

          R         Reminder Patient List

          L         Location

          O         OE/RR Team

          P         PCMM Provider

          T         PCMM Team

PATIENT SAMPLE: L// ocation

Select FACILITY: CAMP MASTER//    CAMP MASTER

Select another FACILITY: (hit enter key)

     Select one of the following:

          HA        All Outpatient Locations

          HAI       All Inpatient Locations

          HS        Selected Hospital Locations

          CA        All Clinic Stops(with encounters)

          CS        Selected Clinic Stops

          GS        Selected Clinic Groups

Determine encounter counts for: HS// HA All Outpatient Locations

     Select one of the following:

          P         Previous Encounters

          F         Future Appointments

PREVIOUS ENCOUNTERS OR FUTURE APPOINTMENTS: P//  Previous Encounters

Enter ENCOUNTER BEGINNING DATE:  T-365  (AUG 19, 2006)

Enter ENCOUNTER ENDING DATE: T (AUG 19, 2007)

Enter EFFECTIVE DUE DATE: Aug 19, 2007//   (AUG 19, 2007)
Select SERVICE CATEGORIES: A,I//  ?

A        AMBULATORY

H        HOSPITALIZATION

I        IN HOSPITAL

C        CHART REVIEW

T        TELECOMMUNICATIONS

N        NOT FOUND

S        DAY SURGERY

O        OBSERVATION

E        EVENT (HISTORICAL)

R        NURSING HOME

D        DAILY HOSPITALIZATION DATA

X        ANCILLARY PACKAGE DAILY DATA

Select SERVICE CATEGORIES: A,I// 

     Select one of the following:          

          D         Detailed

          S         Summary

TYPE OF REPORT: S// Summary

     Select one of the following:

          I         Individual Locations only

          R         Individual Locations plus Totals by Facility

          T         Totals by Facility only

REPORT TOTALS: I//  Totals by Facility only

Select a REMINDER CATEGORY:    (explain what a reminder category is)

Select another REMINDER CATEGORY:  CAMP 2
Select individual REMINDER: 

Create a new report template: N// O

Print delimited output only: N// y  YES

     Select one of the following:

          C         Comma

          M         Semicolon

          L         Tilde

          S         Space

          T         Tab

          U         Up arrow

Specify REPORT DELIMITER CHARACTER: U// p arrow

Include deceased patients on the list? N// O

Include test patients on the list? N// O

Save due patients to a patient list: N// O

DEVICE: HOME// Q 

DEVICE: HOME// P-MESSAGE

For this exercise, we are going to use some data from a report that has been prepared in advance for you.

First open up excel 

Go to File / Select New

Then Select Save As and save it to your desktop as “Performance Measure Summary” and your student number

Minimize your active documents until you are back to your desktop.

  Double click to open the Word document named: “805 Data”

This document contains summary data in a delimited format (where the column are designated by the up-  

   caret for 14 reminders

0^VAMC REPORT

1^Breast Ca Screen^2^0^TOTAL

2^Cervical Cancer Screen^3^0^TOTAL

3^Colon Cancer Screening^666^150^TOTAL

4^HTN BP <140/90^632^115^TOTAL

5^HTN BP >160/100^632^29^TOTAL

6^DM B/P <140/90^285^43^TOTAL

7^DM B/ >160/100^285^10^TOTAL

8^DM A1C > 9% or Not Done^285^37^TOTAL

9^DM LDL <120^285^37^TOTAL

10^DM Foot Sensation^279^26^TOTAL

11^DM Retinal Exam^285^23^TOTAL

12^Flu Shot (10-04 CDC Criteria)^639^153^TOTAL

13^Pneumococcal Immunization^534^37^TOTAL

14^Alcohol Use Screening^926^17^TOTAL

0^PATIENTS^935^TOTAL

For this exercise, since the data is small, we’ll just copy and paste into Excel.
Select the data beginning with the first 0 and ending with the last word: TOTAL.

Select the keyboard shortcut:  CTRL+C.

This copies the data to the clipboard.  

Switch to Excel by clicking on “Performance measure Summary”

Place Select cell A1

Then right click and select paste
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Select DATA drop down menu

Select TEXT TO COLUMNS
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Clean up.   Delete 0’s in  A1 and A16

Delete Patients, Delete Total

Type in Total in C16

Delete Column E
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Label Column B:   Measure

Label Column C:   Number Applicable

Label Column D:   Number Due

Label Column E:   Score

Center    BOLD         Format Cell C1 and D1:    Alignment / Wrap Text
Inserting a Symbol
Now you will mark the Perf Measures where Lower scores mean better patient results
Select Cell F6
Click on the INSERT drop down menu.  Select Symbol.  Find the down arrow; click on INSERT  then click on  CANCEL and  

Repeat for  Cell F8      

Repeat for  Cell F9     

Repeat for  Cell F10
Apply Formulas
(Column E)
Excel excels at repetitive arithmetic

Arithmetic Operators

+
Addition

-
Subtraction

*
Multiplication

/
Division

%
Percentage

Order of calculations:

Percent

Multiplication and Division

Addition and Subtraction

Comparison

Percent Done  
(Number Applicable – Number due) / Number Applicable

(Number Done)/Number Applicable

=(C2-D2)/C2

Percent Due    
Number Due/Number Applicable

=D6/C6
Type in the following formula into Cell E1:  (Percent Done) 
=(C2-D2)/C2
Click on ENTER key

Type in the following formula into Cell E6:    (Percent Due)
=D6/C6
Click on ENTER key

Copy formulas from Cell E6 to cell E7  and E8 and E9
Select Column E and format column to be percent with one decimal place
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Now copy and past from E2 to E3 thru E5; E7 and E11-15
Note that you are copying the formula not the value.

This is called a Relative Reference.  That means that the as you copy the formula to a different cell it refers to other cells that are located in cells which have the same relationship to the cell which contains the formula.  In this example it subtracts the value of the cell that is adjacent on the left and subtracts it from the cell that is adjacent to that one and then uses the value of the second cell as the divisor.

Add VA Benchmarks. 

	VA Target

	85%

	85%

	72%

	75%

	7%

	75%

	7%

	15%

	79%

	80%

	82%

	75%

	85%

	90%


Format VA Target cells  - 

Green background

Bolded white text
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Add 3 Rows

To first Row Add:   Primary Care Clinic Report

To second Row Add:    July, 2008
Merge Cells, Center, Bold

Add Header: VA Medical Center and CBOC’s
Add Footer:  Data Source: Reminder Reports

Apply Conditional Formatting:

Select cell E2
FORMAT drop down menu / Cells / Conditional Formatting
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Select Cell value is Greater than or equal to   then enter the value .85
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Click Format
Select Font color white and BOLD

Then select Pattern tab and select the background color to be green
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802 Formatting and Graph
Open 805 Formatting and Graph document.
Practice

Repeat Bolding, Centering, Merging cells, re-sizing columns, Applying conditional formatting
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Miscellaneous (802 Formatting and Graph)
Tab 2   Sorting
Tab 2 – Practice Auto Sum
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‘

Use Function to determine Average (Column B)
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Tab 3 – Count Number of times a name appears 
Click On Edit drop down menu
Select Find
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Click FIND ALL
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Sorting
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Graphing
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Click on the chart wizard icon
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Type: Column 
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Trend Line

Select Colorectal Ca Screen columns; Right Click and select Add Trendline
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Right click ; format trend line by making it red.

View Full Screen:

Select View drop down Menu

Select View Full Screen
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Open Word or Power Point

Use ALT plus PRINT SCRN to copy and past into a word document

Setting up a cover sheet – 

Add  new worksheet; rename worksheet Contents

Type in Row 5:  Contents

Type in Row 10:  Data

Type in Row 12:  Graph
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Select Cell B10
Right Click

Select Hyperlink

[image: image42.png]ES Microsoft Excel - B05H_Formating and Graph

5] ple Edt vew Insert Fomat ook Data Window Hep QIMacros Type a question for help
DEHRSSRTEE DB 008 s K mEBe: e

iR D) o) )5 A YResl wth cranaes., Exdrevien. I

< /B I U =55 % 0 W B-&-A-f
1. Data

c D G

Contents:

B; 3

3 cony
paste
Pasts Specal,
Tnsert Coped Cells
Delete
Clear Conterts
Insert Comment
Fomat Cel.
Pk From Drop-down it
Add watch

Create List

Eyperink.

Lok Up.

W 4« » wh\Sheet1 { Charti /Data [ Shest2 { Sheet3 { Sheet4
ran > U5 |auoshapes N\ N DO M Al @ E|Q2-L-A-=

Ready
ndard — Panm NUMEER

s start u # 4 Reminc

ISH_Formating and




Click on Place in this document

Then Select the worksheet
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While the Cell B10 is still active: change the Font to 16
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